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Precision Detectors, Inc. 
Warranty and Electronic End User License Agreement 

 

NOTICE TO USER: THIS IS A CONTRACT. BY INDICATING YOUR ACCEPTANCE DURING 
INSTALLATION, YOU WILL BE ASKED TO ACCEPT ALL THE TERMS AND CONDITIONS OF 
THIS AGREEMENT. 

This Precision Detectors, Inc. (PDI�• ) End User License Agreement accompanies a Precision Detectors 
software product and related explanatory materials. The term "Software" shall include all software 
packages delivered to you by PDI and any upgrades, modified versions or updates of the Software 
licensed to you by PDI. This copy of the Software is licensed to you as the end user for use by you and 
other users of a specific PDI hardware System purchased, leased or rented by you. 

Please read this Agreement carefully. 

PDI grants to you a non-exclusive license to use the Software, provided that you agree to the following: 

1. Use of the Software.  

a) You may install the Software in a single location on a hard disk or other storage device; 
install and use the Software on a file server for local execution over your network (but not for 
the purpose of copying onto a local disk or other storage device); for use only with the 
specific system; 

b) You may make backup copies of the Software; 

c) You may transfer the Software from one computer to another over your network, or relocate 
the Software on your site, but you may not copy it to additional sites over the network or 
make additional copies for use on additional networks or sites for use with other hardware; 

d) You may copy the Software to the personal computer of Users and such Users may use the 
software to examine, recompute and print out files collected in conjunction with the System; 

e) You may obtain additional electronic copies of the Software directly from PDI for the cost of 
media, handling and shipping. 

2. Copyright.  

The Software is owned by PDI and its suppliers, and its structure, organization and code are valuable 
trade secrets of PDI and its suppliers. The Software is also protected by United States Copyright Law 
and International Treaty provisions. You agree not to modify, adapt, translate, reverse engineer, 
decompile, disassemble or otherwise attempt to discover the source code of the Software. You may 
use trademarks only to identify printed output produced by the Software, in accordance with accepted 
trademark practice, including identification of trademark owner's name. Such use of any trademark 
does not give you any rights of ownership in that trademark. Except as stated above, this Agreement 
does not grant you any intellectual property rights in the Software. 
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3. Transfer.  

You may not rent, lease, or sublicense the Software. You may, however, transfer all your rights to use 
the Software to another person or entity, provided that you transfer this Agreement with the Software. 

4. Warranty.  

The Software delivered to you is PDI's current standard version and performs as described in PDI's 
brochures. For a period of one year from the date of delivery, PDI agrees to correct defects that the 
user identifies as not performing as described in PDI's brochures. PDI DOES NOT AND CANNOT 
WARRANT THE PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING THE 
SOFTWARE OR DOCUMENTATION. PDI MAKES NO WARRANTIES, EXPRESS OR 
IMPLIED, AS TO MERCHANTABILITY, OR FITNESS FOR ANY PARTICULAR PURPOSE. IN 
NO EVENT WILL PDI BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR 
SPECIAL DAMAGES, INCLUDING ANY LOST PROFITS OR LOST SAVINGS, EVEN IF A PDI 
REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR 
FOR ANY CLAIM BY ANY THIRD PARTY. Some states or jurisdictions do not allow the 
exclusion or limitation of incidental, consequential or special damages, or the exclusion of implied 
warranties or limitations on how long an implied warranty may last, so the above limitations may not 
apply to you. 

5. Governing Law and General Provisions. 

This Agreement will be governed by the laws of the State of Massachusetts, United States of 
America, excluding the application of its conflicts of law rules. This Agreement will not be governed 
by the United Nations Convention on Contracts for the International Sale of Goods, the application of 
which is expressly excluded. If any part of this Agreement is found void and unenforceable, it will not 
affect the validity of the balance of the Agreement, which shall remain valid and enforceable 
according to its terms. You agree that the Software will not be shipped, transferred or exported into 
any country or used in any manner prohibited by the United States Export Administration Act or any 
other export laws, restrictions or regulations. This Agreement shall automatically terminate upon 
failure by you to comply with its terms. This Agreement may only be modified in writing signed by 
the President of PDI. 

6. Notice to Government End Users.  

If this product is acquired under the terms of; 

(i) a GSA contract - Use, reproduction or disclosure is subject to the restrictions set forth in the 
applicable ADP Schedule contract; 

(ii)  a DOD contract - Use, duplication or disclosure by the Government is subject to restrictions 
as set forth in subparagraph (c) (1) (ii) of 252.227-7013; 

(iii)  a Civilian agency contract - Use, reproduction, or disclosure is subject to 52. 227-19 (a) 
through (d) and restrictions set forth in the accompanying end user agreement. 

7. Only Terms and Conditions.  

These Terms and Conditions are the only terms and conditions related to the use of this software; they 
supercede any previous agreement with respect to the software, and may only be altered in a written 
agreement signed by PDI and you. 

Unpublished rights reserved under the copyright laws of the United States. Precision Detectors, Inc., 34 
Williams Way, Bellingham MA 02019. 

Your acceptance or decline of the foregoing Agreement [was or will be] indicated during installation. 
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Chapter 1 

Introduction 

 

1.1 OVERVIEW 

This program is provided to process multi-angle light scattering data to generate Zimm plots and 
determine a variety of macromolecular parameters including: 

�x�� Molecular Weight 

�x�� Second Virial Coefficient  

�x�� Radius of Gyration 

�x�� Information about the shape of the molecule 

The program employs a two step process that involves: 

�x�� The determination of calibration constants for the system using a standard. 

�x�� Using the calibration constants to analyze from the sample. 

This software is used with the PDExpert Workstation Platform. 

A discussion of the theory of static light scattering is presented in Appendix A. 

1.2 INSTALLATION 

1.2.1 Loading the Software 

To load the software onto the personal computer: 

a) Place the distribution diskette in the CD-ROM drive. If your computer is configured for Autorun, a 
Welcome screen will be presented (if your computer is not configured for Autorun, select Setup.exe on 
the CD to access the Welcome screen). 

b) The Install program presents a series of dialog boxes that are self-explanatory. When you access the 
dialog box that presents the programs to load, select PrecisionMALS. The software license key that is 
provided with the system will allow you to load the program. 

     1 
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1.3 GENERAL CONVENTIONS USED IN THIS MANUAL 

This program is a Windows�“  application that follows general Windows conventions. All windows, dialog 
boxes, controls, short cut keys, scroll bars, etc. operate according to standard Windows procedures. For 
the sake of brevity, we use the following conventions: 

�x�� It is understood that the OK button is to be clicked (or the ENTER key on the keyboard is to be 
pressed) to accept the settings and close a dialog box. 

�x�� It is understood that the CANCEL  button is to be clicked (or the ESC key on the keyboard is to 
be pressed) to close a dialog box and preserve the original settings. 

�x�� The APPLY button is to be clicked to change settings without closing the dialog box. 

�x�� Common dialog boxes and commands that are similar to other Windows programs are not 
described (e.g. the Open dialog box, is identical to that used in programs such as Word). 

When we are describing a dialog box or window, the name of the window will appear in italics: 

Access the Correlation Function �G�L�D�O�R�J���E�R�[���« 

When a button (or a command from a menu), is to be chosen, the button (command) is shown in italics: 

 To initiate data collection, click Start on the menu bar. 

On-line help is available by pointing to the field of interest and pressing F1. 

 

     1 
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Chapter 2 

The Main Window 

 

2.1 THE MAIN WINDOW 

The Main window of the program (Figure 2-1) consists of three regions: 

 
Figure 2-1:  The Main Window 

�x�� Menu bar (Section 2.2) 

�x�� Data region (Section 2.3) 

�x�� Information region (Section 2.4) 

     2 
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2.2 MENU BAR 

2.2.1 File Menu 

The File menu includes the following commands: 

�x�� Load Workspace - Used to import a data file with calibration factors or with analytical results. 
The file will be indicated in the information region. 

�x�� Import Data File - Used to import a raw data file. The file will be indicated in the information 
region. 

�x�� Save Workspace - Used to save a data set with calibration factors or with analytical results using 
the present file name. 

�x�� Save Workspace As - Used to save a data set with calibration factors or with analytical results 
with a new file name. 

�x�� Print - Prints the present plot (raw data or Zimm plot), calibration constants (if generated) and 
results (if generated). 

�x�� Print Preview - Displays the present plot (raw data or Zimm plot), calibration constants (if 
generated) and Results (if generated) on the monitor. 

�x�� Exit - Closes the program. Any baseline definitions and data (calibrations, or results) will be 
erased. 

2.2.2 Regions Menu 

The Regions menu includes the following commands: 

�x�� Set Baseline Region - See Setting the Baseline Region for information (Section 3.2). 

�x�� Set Integration Region - See Setting the Integration Region for information (Section 3.3). 

�x�� Clear Regions - Presents a dialog box to indicate if the Baseline region or Integration region(s) 
that have been defined should be erased. 

2.2.3 Calculations Menu 

The Calculations menu includes the following commands: 

�x�� Calibrate - Generates calibration factors from a data set. 

�x�� Analyze - Generates results from a data set and calibration factors. 

�x�� Settings - Presents the Calculation Settings dialog box, which is used to indicate various options 
in the Zimm plot (Section 3.4). 

2.2.4 Help Menu 

The Help menu includes the following commands: 

�x�� About - Presents the version number and build number of the program. Please provide this 
information to Precision Detectors when inquiring about this program.  

�x�� Help - Accesses the on-line help file. 
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2.3 THE DATA PANE 

When a file is opened, the data pane presents the raw data. A typical data pane is shown in Figure 2-2 and 
a typical plot containing analyzed data is shown in Figure 2-3. 

 

Figure 2-2:  Data Pane with Raw Data 

     2 
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Figure 2-3:  Data Pane with Analyzed Data (Zimm Plot)  

The format of the Raw Data plot and the Zimm plot can be edited by the user. If you right click in the 
plot, a pop-up menu with the following commands will be presented: 

Zoom - Allows for expansion of a user selected region. To define the region to be "zoom"ed: 

a) Place the mouse at a corner of the desired region. 

b) Drag it to the opposite corner of the desired region. 

c) Release the mouse button. 

Unzoom - Returns the plot to a full scale presentation. 

Grid Display - Used to indicate if the major grid lines and/or the minor grid lines should be presented on 
the plot. The major and minor grids can be used for ease in reading the plot. 

Legend - Provides the identification color for each detector in the plot. 
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2.4 THE INFORMATION TREE 

The Information Tree, which is on the right side of the display, lists all files that have been loaded, 
sample information about the various files, calibration constants and results from the calculations. 
Example of sample trees are presented in Figures 2-4 and 2-5.  

 

Figure 2-4:  Typical Information Tree 

The information tree can present the results of the calculations, as shown in Figure 2-5.  

     2 
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Figure 2-5:  Results in the Information Tree 
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To add a raw data file to the information tree, press Import Data File on the File menu. Raw data files are 
indicated by a red icon, while files which have been used for calibration are indicated via a green icon. 

To add a workspace (which includes raw data and calibration data or raw data, calibration data and 
analyzed data) press Load Workspace on the File menu. 

When a file is used for calibration, the calibration constant for each detector used to calibrate as well as 
the region used for the baseline and the integration and the response will be included.  

When a file has been analyzed, the Molecular Weight (MW), the Radius of Gyration (Rgz) the second 
virial coefficient A2 and the correlation coefficients for the various shape models will be presented in the 
information tree. In addition, the regions used for the baseline and the integration and the response will be 
included and can be viewed by expanding the menu. 

To save data, use Save Workspace As... on the File menu. 

To erase a file from the information tree, highlight it, right click and select Remove.  

     2 
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Chapter 3 

Creating a Zimm Plot 

 

3.1 OVERVIEW 

The following steps are involved in the generation of a Zimm Plot: 

a) Open the file containing the data to be used for calibration. 

b) Define the Baseline Region for the calibration data (Section 3.2). 

c) Define the Integration Region for calibration data (Section 3.3). 

d) Press Calibrate. 

e) Open the file containing the data to be analyzed. 

f) Define the Baseline Region for the analysis data. 

g) Define the Integration Region for the analysis data 

h) Press Analyze to present the Zimm plot. 

If desired, you can change the format of the Zimm plot via the Calculation Settings dialog box as 
described in Section 3.4. 

3.2 SETTING THE BASELINE REGION 

To set the baseline region: 

a) Select Set Baseline Region on the Region menu. The cursor is changed to a plus (+) sign. 

b) Move the cursor to the point where you want to start to define the baseline and depress the left button 
on the mouse. 

c) Drag the mouse over the desired baseline region. The selected region will be indicated in red as 
shown in Figure 3-1. 

     3 
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Figure 3-1:  Setting the Baseline Region 

d) Release the mouse button. The selected region will be indicated by a narrow blue bar on the bottom of 
the plot. 

Note: Only one baseline region can be determined for a data set. 
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3.3 SETTING THE INTEGRATION REGION 

To set an integration region: 

a) Select Set Integration Region on the Region menu. The cursor will be changed to a plus (+) sign. 

b) Move the cursor to the point where you want to start to define the integration region and depress the 
left mouse button. 

c) Drag the mouse across the region that should be integrated. The selected region will be indicated in 
red as shown in Figure 3-2. 

 

Figure 3-2:  Setting the Integration Region 

d) Release the mouse button. The selected region will be indicated by a narrow green bar on the bottom 
of the display. 

     3 
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3.4 CALIBRATION 

To calibrate the system: 

a) Open the file to be used to generate calibration factors. 

b) Select the Baseline Region as described in Section 3.2. 

c) Select the Integration Region as described in Section 3.3. 

d) Press Calibrate on the Calculations menu to present the Calibration dialog box (Figure 3-3). 

 

Figure 3-3:  Calibration Dialog Box 

e) Enter the Molar mass and Second virial coefficient (if the value of the Second virial coefficient is not 
known, enter 0.00). 

f) Press OK. The calibration constants will be calculated and listed on the information pane. 
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3.5 ANALYZING A DATA FILE 

Analysis of a data file involves the application of the calibration constants to a raw data file to generate 
the Zimm plot (Figure 3-4).  

 

Figure 3-4:  Zimm Plot 

Various elements of the Zimm plot can be deleted via the Calculations Settings dialog box (Section 3.6). 

The results and shape interpretation data is indicated in the Results section of the Information tree (Figure 
3-5). A discussion of this data is presented in Section 3.8.  

     3 
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Figure 3-5:  Information Tree 
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3.6 CALCULATIONS SETTINGS DIALOG BOX 

The Calculations Settings dialog box (Figure 3-6) is used to indicate a variety of data presentation options 
for the Zimm plot. If the desired element should be included in the plot, check the appropriate box.  

 

Figure 3-6:  Calculations Settings Dialog Box  

Angular extrapolation lines - connect all points corresponding to a specific detector. 

Concentration extrapolation lines - connect all points corresponding to a given concentration. 

Zero angle extrapolation line - line connecting all "zero angle points". 

Zero concentration extrapolation line - line connecting all "zero concentration points". 

Zimm Plot Scaling Factor - The range is from 1-99999. 

These settings can be set before or after the Zimm plot is obtained. 

3.7 VIEWING STORED DATA 

Stored data can be retrieved via the Load Workspace command on the File menu. The raw data will be 
presented in the Data Pane and the complete report, including the calibration constants, the regions used 
for baseline and integration and the results will be presented in the information Pane. 

To view the Zimm plot, press the Results entry on the information pane.  

     3 
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3.8 RESULTS AND SHAPE INTERPRETATION 

The Results section of the Information panel presents the Molecular Weight, the Radius of Gyration and 
the Second Virial Coefficient (Figure 3-7). 

 

Figure 3-7:  Results Section - Information Panel 

The Shape Interpretation section (Figure 3-8) of the Information panel presents the value of the 
correlation coefficient (r2) using the various calculations describing the shape of the particle. The shape of 
the molecule is best described by the model with the highest value of r2. 

 
Figure 3-8:  Shape Interpretation Section - Information Panel 

Note: The user should be aware that inhomogeneity in either the shape or the size of the particle may lead 
to ambiguity in the interpretation of the data. 

The equations used for the various models include: 

Random Coil - The light scattering expression for a random coil is presented in equation 3-1. 

  
where: 

  
 

  
 
 Rg is the radius of gyration 
 n is the number of statistical polymer segments 
 b is the root mean square length of the statistical segment 

3-1 
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Sphere - The light scattering expression for a random coil is presented in Equation 3-2. 

  
where:  

 
D is the diameter of the sphere 

Rod - The light scattering expression for a rod is presented in Equation 3-3. 

 
where:  

 
L  is the rod length 

Thin Disk - The light scattering expression for a thin disk is presented in Equation 3-4. 

 

where: 

 
D = diameter of disk 
J1(x) = Bessel function of the first kind 

Star - The light scattering expression for a star is presented in Equation 3-5. 

 
where:  

 
f is the number of arms on the star

3-2 

3-3 

3-4 

3-5 

     3 
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Flexible Ring - The light scattering expression for a flexible ring is presented in Equation 3-6 

  
where: 

 

 
ID���L�V���'�D�Z�V�R�Q�¶�V���,�Q�W�H�J�U�D�O 
n = # of statistical polymer segments 
b = root-mean-square length of statistical segment 

A description of related mathe�P�D�W�L�F�D�O���I�X�Q�F�W�L�R�Q�V���V�X�F�K���D�V���%�H�V�V�H�O�¶�V���I�X�Q�F�W�L�R�Q�����7�K�L�Q���'�L�V�N���P�R�G�H�O�������'�D�Z�V�R�Q�¶�V��
Integral (Flexible Ring model), calculation of correlation coefficients can be found in mathematics 
reference books. 

 

3-6 
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Appendix A 

Theory of Light Scattering 

 

A.1 OVERVIEW 

Light Scattering refers to the process in which light from an incident polarized laser beam is scattered in 
all directions when it interacts with a molecule or particle. Light scattering is an everyday occurrence and 
was first described by Lord Rayleigh in the late 18�����¶�V�����$�Q���H�[�D�P�S�O�H���R�I���O�L�J�K�W���V�F�D�W�W�H�U�L�Q�J���L�V���W�K�H���V�F�D�W�W�H�U�L�Q�J���R�I��
sunlight by particles in the atmosphere: the sky is blue because shorter visible wavelength radiation (blue 
light) is scattered more strongly by the gas molecules in air than light of longer wavelengths (red light). 

There are two general techniques for the measurement of physical properties of polymers (synthetic 
polymers and natural polymers such as proteins and polysaccharides), virons, liposomes and particles. 

�x�� Static Light Scattering (also known as Rayleigh scattering or classical light scattering) - The 
intensity of the scattered light from the sample dissolved in the solvent. This difference between 
the two measurements can be used to determine the average molecular weight and Rg (radius of 
gyration). To complete the molecular weight determination, the concentration of the compound of 
interest is required (typically obtained from a refractive index detector or an absorbance detector). 
Static Light Scattering is described in Section A.3. 

�x�� Dynamic Light Scattering (also known as Quasi-elastic scattering, Photocorrelation 
Spectroscopy, or Beat Spectroscopy) - The fluctuations of the intensity of the scattered light is 
used to determine the diffusion coefficient of the molecules as they move in solution (Brownian 
motion). The Stokes-Einstein equation is used to determine Rh (the hydrodynamic radius of the 
molecule). Dynamic Light Scattering is described in Section A.4. 

Static and Dynamic measurements can be made on a sample in a cuvette or in a flowing stream such as 
that found in high performance liquid chromatography (HPLC), size exclusion chromatography (SEC) or 
gel permeation chromatography (GPC). In flowing streams, measurements are made on each elution slice 
using a unique light scattering design and very fast digital signal processors (which are essentially special 
purpose computers).  

This chapter describes the fundamentals of the theory of light scattering. A short list of references for 
additional reading is presented in Section A.5. 

     A 



A-2  PrecisionMALS �²  Appendix A 

A.2 THE PHYSICAL BASIS OF LIGHT SCATTERING  

Light consists of perpendicular electric and magnetic fields that oscillate in a direction that is 
perpendicular to the direction of propagation of the light as shown in Figure A-1. When light strikes a 
molecule, the electrons will experience a force due to the electric field and will move slightly. This 
movement will induce an oscillating dipole moment that will radiate light in all directions at the 
oscillating frequency. This radiated light is the scattered light that is detected and processed as described 
below. 

 
Figure A-1:  Light Scattered by a Molecule 

Figure A-1 describes the spatial arrangement of the incident light and scattered light in the light scattering 
experiment. The light is polarized in the vertical direction, thus the electric field will oscillate in the Z-
direction and the magnetic field will oscillate in the X direction.  

A diode laser, which is a monochromatic source of light that can be focused to a very small point in the 
center of the sample cell, is used in PDI light scattering systems. Typical sources include a semiconductor 
laser that can provide 20 to 30 mW at 685 nm and another which provides 100 to 150 mW at 800 nm. The 
scattered light is collected at a given angle and orientation (e.g. 15o or 90o) from the incident radiation, 
and is used to deduce the desired molecular properties.  

A.3 STATIC LIGHT SCATTERING 

A.3.1 Measuring the Molecular Weight  

Note: Since Precision Detector systems include polarized laser light sources, the equations presented in 
this chapter will be slightly different than those presented in discussions of light scattering when non-
polarized sources are used.  

The electric dipole moment that is induced is shown in equation A-1. 
�Æ          �Æ 

�S��� ���.���(��         A-1
  
 

where: p is the dipole moment 
 �. is the polarizability  
 E is the electric field 
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The polarizability can be related to measurable parameters via equation A-2. 

�ù��� ���0w ���G�Q���G�F�������Œ�1A        A2 

where: Mw is the molecular weight 
  NA  is A�Y�R�J�D�G�U�R�¶�V���Q�X�P�E�H�U���������������[������23 molecules per mole) 

dn/dc is the change in the index of refraction as a function of the change in 
 concentration. It is considered to be a constant for any specified solvent-solute pair under 
 constant operating conditions. 

The oscillating dipole will radiate light in all directions at the oscillating frequency. This is the origin of 
scattered light. If a single molecule has dimensions that are small with respect to the wavelength of the 
incident light , the intensity of the light can be defined by equation A-3.  

I s � ���>�����Œ2 Mw sin2�-�����G�Q���G�F��2 Io]/NA
2 ��o

4 R2
     A-3 

where: I s is the intensity of the radiated light 
I o is the intensity of the incident light 
��o is the wavelength of light in a vacuum 
�-  and R are as defined in Figure A-1 

If we collect light from a volume V of a solution with a concentration c (gm/mL), the intensity of 
scattered light can be found by multiplying equation 8-3 by the number of molecules in the volume V. 
The number of molecules can be expressed by NA c V/Mw. 

Now if we solve for Mw, we obtain equation A-4. 

Mw = NA
2 ��o

4 R2 Is ���������Œ
2 Mw sin2���-���F�����G�Q���G�F��2 Io V    A-4 

Collecting all the constants and instrumental parameters into an overall instrumental constant, A, we 
obtain equation A-5. 

Mw = Is / A c (dn/dc)2 Io        A-5 

Equation 8-5 can be used to measure the molecular weight Mw of small molecules at any scattering angle 
�������,�W���V�K�R�X�O�G���E�H���Q�R�W�H�G�����K�R�Z�H�Y�H�U�����W�K�D�W���O�D�U�J�H�U���P�R�O�H�F�X�O�H�V���V�F�D�W�W�H�U���O�H�V�V���O�L�J�K�W���D�W���K�L�J�K���Y�D�O�X�H�V���R�I�������W�K�D�Q���D�W���O�R�Z��
angles because of interference effects caused by the fact that light scattered from one part of the molecule 
travels a different distance from another part of the molecule, and is not in phase with light scattered. This 
phenomenon can be quantified by defining the light scattering form factor (equation A-6). A more 
detailed discussion of the form factor is presented in Section A.3.3. 

�3��������� ���V�F�D�W�W�H�U�H�G���L�Q�W�H�Q�V�L�W�\���D�W���D�Q�J�O�H�����������V�F�D�W�W�H�U�H�G���L�Q�W�H�Q�V�L�W�\���D�W���D�Q�J�O�H���-��  A-6 

�,�W���V�K�R�X�O�G���E�H���Q�R�W�H�G���W�K�D�W���3���������F�D�Q���E�H���Z�U�L�W�W�H�Q���D�V���D���V�H�U�L�H�V���D�V���V�K�R�Z�Q���L�Q���H�T�X�D�W�L�R�Q���$-7. 

�3��������� ������- 1/3( q 2 Rg
2) +          A-7 

where: q��� �������Œ���Q���V�L�Q����������������o 
R is the radius of gyration of the molecule 
n is the index of refraction of the liquid 
��o is the wavelength of light in a vacuum 

For scattering at 15o and 90o, equation 8-7 can be expressed as equations A-8 and A-9, respectively. 

�3��������� ����- 26.3 (Rg �Q������o)
2       A-8 

�3��������� ����- 0.0897 (Rg �Q������o)
2        A-9 

We present a table of P values for 15o and 90o degrees as a function of molecular weight (for molecules 
with molecular weight from 104  to 108 Daltons) in Table A-1. These values assume that the molecules are 
random coils. 

     A 
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Table A-1:  Value of P(90o) and P(15o�����I�R�U����o = 685 nm, n = 1.5 

Mw Rg (Approx) nm P(90o) P(15o) 
5 x 103 2.3 0.9993 1.0000 
5 x 104 7 0.9993 0.9998 
5 x 105 23 0.9993 0.9976 
5 x 106 70 *1 0.9780 
5 x 107 230 *1 0.7622 

*1 values depend on shape 

�,�I���W�K�H���Y�D�O�X�H���R�I���3����) found in equation A-7 is below 0.7, higher order components become important. In 
�W�K�L�V���F�D�V�H�����3���������G�H�S�H�Q�G�V���R�Q���5g and also on the shaper of the molecule as shown in Figure A-2. 

 
Figure A-2:  Values of p-1���������D�V���D���I�X�Q�F�W�L�R�Q���R�I���T2<Rg2> for various particle shapes: 1 = Sphere, 
   2 = Gaussian Coils, 3 = Rods. 

�,�W���L�V���F�O�H�D�U���W�K�D�W���D�O�O���W�K�U�H�H���P�R�O�H�F�X�O�D�U���V�K�D�S�H�V���\�L�H�O�G���W�K�H���V�D�P�H���Y�D�O�X�H���R�I���3���������Z�K�H�Q���T2 <Rg2>is less than 
�D�S�S�U�R�[�L�P�D�W�H�O�\���������$�V���W�K�H���Y�D�O�X�H���R�I���3���������L�Q�F�U�H�D�V�H�V�����W�K�H���V�K�D�S�H���R�I���W�K�H���P�R�O�H�F�X�O�H���F�O�H�D�U�O�\���L�Q�I�O�X�H�Q�F�H�V���W�K�H���O�L�J�K�W��
scattering intensity.  
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A.3.2 Using Refractive Index Measurements to Measure Concentration 

Refractive index measurements can be used in conjunction with static light scattering measurements to 
determine the concentration of the compound in the chromatographic slice.  

The difference in refractive index between the solution under study and the pure solvent is measured by 
passing a light beam thru two cells as shown in Figure 7-3. One of the cells contains pure solvent and the 
other contains the eluant as it passes thru the cell after the column. The cell with the pure solvent should 
be filled with the solvent prior to the separation and should be at the same temperature as the eluant. 

The observed signal (RI), which corresponds to the deviation of the light beam is proportional to the 
difference in the refractive index of the fluid in the two cells as shown in equation A-10  

RI = B (dn/dc) c        A-10 

where: B is an instrumental constant  
c is the concentration of the sample in the solvent 
dn/dc is the change in the index of refraction of the solution as a  function of 

concentration. It is considered as a constant for any  specified solvent-solute pair under 
constant operating conditions 

A.3.3 The Form Factor 

The form factor at a particular angle is the ratio of the signal at that angle when compared to the signal 
expected at the theoretical angle of 0o (where there is not form factor) as indicated by equation 8-6. The 
importance of the form factor is that small molecules (e.g. those which have a radius that is < 10 nm, 
which is small when compared to the wavelength of the incident light) are studied, generate comparable 
signals at all angles, while large molecules generate signals that are smaller at higher angles and larger at 
small angles 

A.3.4 Characteristics of Low-Angle (15o) Light Scattering  

Low Angle light scattering data is collected at a 15  angle to the incident beam and is typically used for 
determination of the molecular weights of large molecules. This measurement angle is especially useful 
for the study of proteins with molecular weight of greater than 1,000,000 Daltons and for random coils 
with molecular weight between 200,000 Daltons and about 10,000,000 Daltons. 

In addition, 15o data is also used with 90o data to measure Rg, the radius of gyration of molecules over a 
limited range of sizes (12-150 nm) using static light scattering analysis.  

A.3.5 High Angle Light Scattering  

Low angle light scattering data is collected at a 90  angle to the incident beam and is typically used with 
static light scattering analysis to measure the molecular weight of smaller molecules such as proteins with 
a molecular weight below 1,000,000 Daltons, random coils with molecular weight below 200,000 Daltons 
and for lower molecular weight non-spherical coil polymers. In addition, it is used with dynamic light 
scattering analysis to measure Rh, the hydrodynamic radius of molecules and particles from 1 to 1,000 
nm. 

     A 
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